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Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
when there is no open title, and the name of the open title when a title is open.

To move the window, drag the title bar.    Note: You may also move a dialog box by dragging 
the title bar of a dialog box.

The title bar contains the following elements:

* Application Control-menu button
* Maximize button
* Minimize button
* Name of the application or the name of the open title
* Restore button
* Help button



Scroll Bars

These are displayed at the right and bottom edges of the document window.    The scroll 
boxes inside the scroll bars indicate your vertical and horizontal location in the document.    
You may use the mouse to move to other parts of the document by dragging the scroll boxes
within the scroll bars.



Size Command (System Menu)

This command displays a four-headed arrow which allows you to size the active window 
using the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you require.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move Command (Control Menu)

This command displays a four-headed arrow which allows you to move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.



Minimize Command (Application Control Menu)

This command reduces the ProTech Media Viewer window to an icon.

Shortcut
Mouse: Click the minimize icon on the title bar.



Maximize Command (System Menu)

This command enlarges the active window to fill the available space.

Shortcut
Mouse: Click the maximize icon on the title bar; or double-click on the title bar.



Close Command (Control Menus)

This command closes the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu will only close one window at a time.    You may close all windows at 
once using the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes an open title

ALT+F4 closes the ProTech Media Viewer window or dialog box



Restore Command (Control Menu)

Use this command to return the active window to the size and position of that window before
you chose the Maximize or Minimize command.



Switch To Command (Application Control Menu)

This command displays a list of all open applications.    Use this "Task List" to switch to or 
close any application listed.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



File Menu Commands

The File menu offers the following commands:

Open Open a MediaView title.
Close Close a MediaView title.
Print Print the current topic.
Print Preview Display the current topic as it would appear printed.
Print Setup Set margins, page orientation, select a printer, select 

printer connection.
Exit Exit the ProTech Media Viewer.



Open Command (File Menu)

This command opens an existing title.    The command presents an Open dialog box, where 
you may specify which file to open.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open Dialog Box

The dialog box allows you to specify which file to open:
File Name

Type or select the filename for the title you want to open.    This box lists files with the 
extension you select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open.    This application only opens Microsoft Media 
View files which normally have an 'M14' extension.



Close Command (File Menu)

This command closes the open title.

Shortcuts
Keys: CTRL+F4



Print Command (File Menu)

This command prints the current topic.      The command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print Dialog Box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup or Properties option 
to change the printer and printer connection.

Print range
Select the range of pages you wish to print.

Copies
Specify the number of copies you require printed.



Print Progress Dialog

The Printing dialog box is shown while the ProTech Media Viewer is sending output to the 
printer.    The page number displayed indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview Command (File Menu)

This command displays the current document as it would appear when printed.    When you 
choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed as they will print.    The print preview toolbar offers 
you options to view either one or two pages at a time; to move back and forth through the 
document; to zoom view in and out of pages; and to initiate printing.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Display the print dialog box to initiate a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a more distant look at the printed page.
Close

Close the print preview window.



Print Setup Command (File Menu)

This command displays a Page Setup dialog box, where you may alter the page size, paper 
orientation and margins.

Choose the Printer option to select a printer.    This command presents a Print Setup dialog 
box, where you may select the printer and the printer connection.



Page Setup Dialog Box

The following options allow you to change the page description.
Printer

Choose the Printer option to select a printer.    This command presents a Print Setup 
dialog box, where you may select the printer and the printer connection.

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper on which the document will be printed.

Paper Source
Some printers offer multiple trays for different types and/or sizes of paper.    Specify the 
appropriate paper tray here.



Print Setup Dialog Box

The following options allow you to select the destination printer and the printer connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the currently installed printers displayed in the box.    

Note:    New printers are installed and ports configured from the Windows Control Panel. 



1, 2, 3, 4 Command (File Menu)

Use the numbers and filenames listed at the bottom of the File menu to open any one of the 
last four titles closed.    Select the number corresponding to the title you want to open.



Exit Command (File Menu)

This command will end your ProTech Media Viewer session.    You may also use the Close 
command on the application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.
Keys: ALT+F4



Edit Menu Commands

The Edit menu offers the following commands:

Copy Copy data from the current topic to the clipboard.
Bookmarks Edit the bookmarks for the current title.
Annotations Edit the annotations for the current title.
Find in Index Display the title's index.
Search for 
Text

Search for text in the title.

Settings Edit the application settings.



Copy Command (Edit Menu)

This command copies data from the current topic to the clipboard.

Note:    Copying data to the clipboard replaces the clipboard's previous contents.

Shortcuts

Toolbar:
Keys: CTRL+C



Bookmarks Command (Edit Menu)

This command presents a Define and Go To Bookmarks dialog box for the current title.    
Bookmarks are used to mark places or topics in the title so you may return to them quickly 
later.

Shortcuts

Toolbar:
Keys: CTRL+G



Define and Go To Bookmarks Dialog Box

The following options manipulate bookmarks:
New Bookmark Name

The name of the current topic will automatically become the bookmark name if the Add 
option is taken.    However, the bookmark name may be edited (customised) before 
selecting the Add option.

Bookmarks
This list shows the bookmarks which current exist in the title.

Go To
This option is only available when one of the currently existing bookmarks is selected.    
The topic associated with the bookmark selected will be displayed if the Go To option is 
chosen.

Add
This option adds the new bookmark to the list of bookmarks currently existing in the title.
The bookmark created in this way will be associated with the current topic and scroll 
position.

Delete
This option is only available when one of the currently existing bookmarks is selected.    
The selected bookmark will be deleted if the Delete option is chosen.



Annotations Command (Edit Menu)

This command presents an Edit Annotation dialog box for the current title.      Annotations are
personal notes or comments which may be added to topics in the title.

Shortcuts

Toolbar:
Keys: CTRL+A



Edit Annotation Dialog Box

The following options manipulate annotations:
Annotations

This list shows the titles of topics for which annotations have been added.    Selecting an 
item in this list will display the related annotation text below.

Text
This shows the text annotation for the topic selected above.

Delete
This option will delete the annotation currently displayed in the dialog box.

Go To
This option will display the topic associated with the annotation shown in the dialog box.



Find in Index Command (Edit Menu)

This command presents a Keyword Index dialog box for the current title.

Shortcuts

Toolbar:
Keys: CTRL+I



Keyword Index Dialog Box

Use the options in this dialog box to find topics with specific predefined keywords:
Type a Word

Enter a word or part of a word here to select a keyword from the group listed below.
Index List

The list of keywords in the currently displayed keyword group.
Keyword Group

One or more groups of keywords provided in the currently open title.    This option allows 
you to choose which group of keywords to display.

OK
If the selected keyword only has one topic associated with it, choosing the OK option will 
display that topic.    If more than one topic is associated with the selected keyword the 
OK option presents a Keyword Index Search Results dialog box.



Keyword Index Search Results Dialog Box

Use the options in this dialog box to go to a topic associated with a specific keyword :
Topics Containing Keyword

This list displays the names of the topics associated with the selected keyword.
Go To

This option displays the selected topic.

Note:    This dialog box may be stretched to show more of the topic names.



Search for Text Command (Edit Menu)

This command presents a Search dialog box.    This is a full text searching feature for the 
currently open title.

Shortcuts

Toolbar:
Keys: CTRL+F



Search for Text Dialog Box

Use the options in this dialog to find a topic based on a textual search criteria:
Search Word or Phrase

Enter the word or phrase you wish to search for.    

Note:    Words or phrases may be combined with special operators like AND, OR and 
NEAR.    See also:

Using Search Operators
Using the Thru Operator
Using Multiple Search Operators

AND Multiple Search Words
If this option is checked and more than one word is entered then topics will only be 
located by the search if all of the words exist in the topic.

Current Topic
Select this item if you want to limit the search to the current topic.

Groups
Select this item if you want to limit the search to one or more selected groups.

All Topics
Select this item if you want to search through all the text in the title.

OK
This option presents a Search Results dialog box.



Search Results Dialog Box

Use the options in this dialog to go to a topic which matches the search criteria :
Topics Containing Search Criteria

This list displays the names of the matching topics.
Go To

This option displays the selected topic.

Note:    This dialog box can be stretched to show more of the topic names.



Using Search Operators

When you use the Search button to search for information, you can use the search operators
AND, OR, NOT, and NEAR to narrow your search. Each operator is described below. You can 
enter an operator in either lowercase or uppercase letters ("and" is interpreted the same as 
"AND").

AND
The AND operator selects topics containing all phrases connected by AND operators. If a 
phrase does not appear in quotes, any space between words in the phrase is assumed to 
represent an implicit AND. For example:
Bees love Honey
This phrase finds any topic containing the three words "Bees," "love," and "Honey." This is 
the same as specifying Bees AND love AND Honey. However, when quotes are used, ProTech 
Media Viewer searches for the entire phrase. For example:
"Bees love Honey"
This phrase finds any topic containing the phrase "Bees love Honey."

OR
The OR operator selects topics containing either phrase connected by OR operators. For 
example:
Bees OR Honey
This query displays topics containing either the word "Bees" or the word "Honey."

NOT
The NOT operator selects any topic that does contain the phrase preceding NOT, but doesn't
contain the phrase following NOT. For example:
Bees NOT Honey
This query finds topics containing the word "Bees" but not the word "Honey."

NEAR
The NEAR operator selects any topic in which one phrase appears within a certain number of
words of the second phrase. The default value is 8 words. For example:
Bees NEAR Honey
This query finds any topic in which the word "Bees" appears within 8 words before or after 
the word "Honey."    Use the Settings Command (Edit Menu) to alter the Search Nearness 
Value.



Using the THRU Operator

The THRU operator lets you search on numeric ranges such as dates, times, numbers, and 
epochs. You can also use the THRU operator to search on alphabetical ranges, such as on all 
words from Bee THRU Beetle. The search result would be all words alphabetically falling 
between "bee" and "beetle." (This search would include the words "bee" and "beetle.") An 
example of a numeric search would be searching on all dates in a given year:    1/1/1941 
THRU 12/31/1941.

Note:    Only simple, single word expressions may be used with the THRU operator. You 
cannot use multiple words, parentheses, or phrases in quotes with the THRU operator.



Using Multiple Search Operators

When you use the Search button to search for information, you can use multiple search 
operators to define more complex search criteria. For example, if you enter honey AND bees 
NOT hives in the Search by Word box, ProTech Media Viewer will match topics that contain 
the words "honey" and "bees" but do not contain the word "hives."

Note:    By default, operators are evaluated from left to right. You can use parentheses to 
specify a different order - operators within parentheses are evaluated first.

This query Searches for
honey OR bees AND hives Topics containing either the word honey or the 

word bees in addition to the word hives.
honey OR (bees AND 
hives)

Topics containing the word bees and the word 
hives or topics containing the word honey.

honey OR bees NOT hives Topics containing either the word honey or the 
word bees but not the word hives.

honey OR (bees NOT 
hives)

Topics containing the word bees but not the 
word hives or topics containing the word honey.



Settings Command (Edit Menu)

This command displays a Settings dialog box where the application settings may be 
changed.

Shortcuts
Keys: CTRL+S



Settings Dialog Box

Use the options in this dialog to alter way the ProTech Media Viewer displays information:
Directory

Enter the name of the directory into which the annotations and bookmark files should be 
placed.    These files have the same name as the open title with the file extensions 
".ANN" and ".BKM" respectively.    The directory name may only be entered when you do 
NOT have a title open.

Auto Advance Gap
This is the number of seconds between each topic displayed when the auto advance 
feature is on.

Search Nearness Value
This is the number of words between search words when the NEAR operator is used.    For
example a search for "dog NEAR cat" would find topics where the word "dog" was found 
within this number of words of the word "cat".

Magnify Text By
This option makes the text larger or smaller in the Media View areas (it does not change 
the text size on any graphical screens or bitmaps).

Metric Margin Units
This option controls whether page margin settings are displayed in metric (millimetre) or 
imperial (inch) measurements.

Show Annotation Marker
This option controls whether or not annotation markers are displayed in the non-scrolling 
title area of topics with annotations attached.

Transparent Windows
This option controls whether or not the background graphic is visible through the text of 
a Media View topic area.    Switching this option off will improve performance on slower 
computers.

Hotspot Highlighting
This option controls whether or not the hotspots on fullscreen graphics "light up" as the 
mouse is passed over them.    Switching this option off will improve performance on 
slower computers.

Show Search Results
This option controls whether or not the results of the last search are shown in topics as 
they are displayed.

Show Hyperlinks
This option controls whether or not the hyperlink jumps appear in a different colour to 
the rest of the text.    This option will only be effective if the open title has been authored 
with the hyperlinks based on the character style "Jump".

Click Sounds



This option controls whether or not sounds are heard when clicking on hotspots.

Advanced Settings
This option displays the Advanced Settings dialog box.

OK
This option saves the changes made to the settings.    The saved changes will apply to all
titles opened thereafter.



Advanced Settings Dialog Box

The options in this dialog box control the way the ProTech Media Viewer displays information:

Auto Resize on Close
This controls whether or not the ProTech Media Viewer resizes a title being opened to the 
same size as the last title closed .    This option only affects titles with a fullscreen 
graphical contents screen.

Extra Information
This controls whether or not additional information is displayed when something 
unexpected happens in the title.    It is provided as an aid to title development.

Border Outside SR/NSR
This controls whether or not a one pixel width black line is drawn around the outside of 
the Media View areas.

Border Between SR/NSR
This controls whether or not a one pixel width black line is drawn between the scrolling 
and non-scrolling Media View areas.

Audio in Auto Advance
This option controls whether or not an audio file associated with a photograph is played 
automatically when a topic is displayed in auto advance mode.

Assume Vertical Scroll Bar
This option controls whether or not a vertical scroll bar is assumed in the scrolling Media 
View area.    Switching this option on improves performance but wastes some space (the 
width of a scroll bar) in any small topics not requiring a scroll bar.

Hide Partial Lines
This option controls whether or not partial lines are displayed at the top and bottom of 
the scrolling Media View area.    Switching this option off improves performance slightly.

History List Size
This option controls how many entries are maintained in the history list.    A smaller 
number uses less computer memory.

Bookmark List Size
This option controls how many bookmarks are allowed in a title.

Kerning Boundary
This option defines the character point size above which Media View should provide 
kerning.    On some computers a low value (for example 0) will make the performance 
dramatically worse.

Search Highlight Colour
This option presents a Colour dialog box.    The selected colour is used to control how the 
results of a text search are displayed in topics.    The effect of the chosen colour is 
apparent when a fullscreen graphic is providing the background to the Media View area.



NSR Colour
This option presents a Colour dialog box.    The selected colour is used as a background to
text in the non-scrolling Media View area.    The chosen colour will not be visible if a 
fullscreen graphic is providing the background.

SR Colour
This option presents a Colour dialog box.    The selected colour is used as a background to
text in the scrolling Media View area.    The chosen colour will not be visible if a fullscreen
graphic is providing the background.



Colour Dialog Box

This dialog allows you to specify a colour.



View Menu Commands

The View menu offers the following commands:

Contents Display the contents page.
Photographs Display the most relevant photograph for the current topic.
Next Display the next topic.
Previous Display the previous topic.
Back Return to the last topic displayed.
History Display a list of the most recent topics displayed.
Auto Advance Toggle the auto advance mode on or off.
Search Results Display the results of the last search.
Next Search Scrolls and selects the next portion of text highlighted from 

the most recent text search.
Main Toolbar Shows or hides the main toolbar.
Photo Toolbar Shows or hides the photograph toolbar.
Status Bar Shows or hides the status bar.



Contents Command (View Menu)

This command displays the title's contents topic.

Shortcuts

Toolbar:
Keys: CTRL+Sh+C or C



Photographs Command (View Menu)

This command displays the most relevant photograph for the current topic.

Shortcuts
Keys: CTRL+Sh+G



Next Command (View Menu)

This command displays the next topic in the browse order.

Shortcuts

Toolbar:
Keys: CTRL+Sh+N or N



Previous Command (View Menu)

This command displays the previous topic in the browse order.

Shortcuts

Toolbar:
Keys: CTRL+Sh+P or P



Back Command (View Menu)

This command returns the last topic displayed.

Shortcuts

Toolbar:
Keys: CTRL+Sh+B or B



History Command (View Menu)

This command presents the History dialog box which provides a list of the most recently 
displayed topics in this viewing session of the open title.

Shortcuts

Toolbar:
Keys: CTRL+Sh+H



History Dialog Box

History
This is a list of the topics most recently displayed in this viewing session of the open title.

Go To
The selected (highlighted) topic is re-displayed when this option is taken.



Auto Advance Command (View Menu)

This command toggles the auto advance mode on and off.    This auto advance feature 
displays the contents of the title, topic by topic, in a pre-determined browse order at a pre-
defined speed (the default speed is 10 seconds per topic).    This may be changed in the Auto
advance gap option of the Settings Command (Edit Menu).

Shortcuts

Toolbar:
Keys: CTRL+Sh+A



Search Results Command (View Menu)

This command controls the display of the Search Results dialog box either showing or hiding 
the results of the last search.

Shortcuts
Keys: CTRL+Sh+R



Next Search Hit Command (View Menu)

This command scrolls and selects the next portion of text highlighted from the most recent 
text search.

Shortcuts
Keys: CTRL+Sh+S



Main Toolbar Command (View menu)

This command toggles the display of the Toolbar on and off.    The Toolbar includes buttons 
for some of the more common commands in the ProTech Media Viewer, such as File Open.    
A check mark appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The Toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools available in the ProTech Media Viewer.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To
Open an existing Media View title.    ProTech Media 
Viewer displays the Open dialog box, from which you 
may locate and open the required file.
Print the current topic.
Set margins, page orientation, select a printer, select 
printer connection.
Copy the current topic to the clipboard.
Display the contents topic for the open title.
Display the previous topic.
Display the next topic.
Return to the last topic displayed.
Display a list of the most recent topics displayed.
Edit the bookmarks for the current title.
Edit the annotations for the current title.
Toggle the auto advance mode on or off.
Display the title's index.
Search for text in the title.
Offers you an index to topics on which help is available.
Offers help on a specific item.



Photo Toolbar Command (View menu)

This command toggles the display of the Photo Toolbar on and off.    The Photo Toolbar 
includes buttons for some of the more common commands available when viewing 
photographs.    A check mark appears next to the menu item when the Photo Toolbar is 
displayed.

See Photo Toolbar for help on using the photo toolbar.



Photo Toolbar

The Photo Toolbar is displayed at the bottom right of the photograph window.    The Photo 
Toolbar provides quick mouse access to many tools used when viewing fullscreen 
photographs.

To hide or display the Photo Toolbar, choose Photo Toolbar from the View menu (ALT, V, O).

Click To
Print the current topic.
Set margins, page orientation, select a printer, select 
printer connection.
Copy the current topic to the clipboard.
Display the previous topic.
Display the next topic.
Display the topic which was visible before the show 
photographs mode was selected.
Display the topic related to the current photograph.
Toggles the auto advance mode on or off.
Play an audio track related to the current photograph.

Status Bar Command (View menu)

This command toggles the display of the Status Bar on and off.    The Status Bar describes 
the action to be executed by the selected menu item or depressed toolbar button, and 
keyboard latch state.    A check mark appears next to the menu item when the Status Bar is 
displayed.

See Status Bar for help on using the status bar.



Status Bar

The Status Bar is displayed at the bottom of the ProTech Media Viewer window.    To display 
or hide the status bar, use the Status Bar command in the View menu.

The left region of the status bar displays the actions of menu items as you use the arrow 
(direction) keys to navigate through the menus.    Descriptions of the actions of toolbar 
buttons will also be displayed in this area when those buttons are depressed.    If, after 
viewing the description of a toolbar button action, you do not wish to execute the command,
release the mouse button AFTER moving the pointer off the toolbar button.

The right region of the status bar indicates which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Video Menu Commands

The Video menu offers the following commands, which are available only when a video is 
open.

Off Turns the video off and returns to the previous topic.
Play Begin playback (in the video window) from the current 

position.
Play 
Fullscreen

Begin playback (fullscreen) from the current position.

Stop Stop video playback.
Rewind Rewind the video to the start position.
Volume Up Turn the volume up.
Volume Down Turn the volume down.
Mute Toggle the video sound off and on.



Off Command (Video Menu)

This command turns the video off and returns to the previous topic.

Shortcuts
Keys: O



Play Command (Video Menu)

This command begins playback (in the video window) from the current position.

Shortcuts
Keys: P



Play Fullscreen Command (Video Menu)

This command begins playback (fullscreen) from the current position.

Shortcuts
Keys: F



Stop Command (Video Menu)

This command stops video playback.

Shortcuts
Keys: S



Rewind Command (Video Menu)

This command rewinds the video to the start position.

Shortcuts
Keys: R



Volume Up Command (Video Menu)

This command turns the video volume up.

Shortcuts
Keys: U



Volume Down Command (Video Menu)

This command turns the video volume down.

Shortcuts
Keys: D



Mute Command (Video Menu)

This command toggles the video sound off and on.

Shortcuts
Keys: M



Help Menu Commands

The Help menu which provides you with assistance using this application offers the following
commands: 

Help Topics Offers you an index to topics on which help is available.
About ProTech
Media Viewer

Displays the version number of this application.

About Title Displays information about the currently open title.



Index Command (Help menu)

This command displays the opening screen of Help.    From the opening screen, you may 
jump to step-by-step instructions for using the ProTech Media Viewer and other reference 
information.

Note:    Once Help has been opened, you may click on the Contents button to return to the 
opening screen of the title at any time.

Shortcuts

Toolbar:
Keys: F1



About Command (Help menu)

Use this command to display the copyright notice and version number of your copy of the 
ProTech Media Viewer.

Copyright © ProTech International Limited 1994-1996

Warning: This computer program is protected by copyright law and international
treaties.    Unauthorised reproduction or distribution of this program, or any
portion of it, may result in severe civil and criminal penalties, and will be

prosecuted to the maximum extent possible under the law.

ProTech International Limited may be contacted as follows:

Mail:
P O Box 324
Nelson
New Zealand 7015

Telephone:
+64 (3) 548 2436

Fax:
+64 (3) 548 2752

Email:
74777.2141@compuserve.com



About command (Help menu)

This command displays information about the currently open title.



Context Help Command

Use the Context Help command to obtain help on some portion of the ProTech Media Viewer. 
When you choose the Toolbar's Context Help button, the mouse pointer will change to an 
arrow and question mark.    Click somewhere in the ProTech Media Viewer window, (such as 
another Toolbar button) and the relevant Help topic will be displayed for that item.

Shortcuts

Toolbar:
Keys: SHIFT+F1



Popup (Context) Menu Commands

Clicking the right (alternate) mouse button will display a popup menu relevant to the item 
clicked upon.    These popup menus will offer a selection of the following commands.

Annotation Edit the annotation for the current topic.
Auto Advance Toggle the auto advance mode on or off.
Back Return to the last topic (or photograph) displayed.
Close Display the topic related to the photograph.
Copy Image Copy the embedded image to the clipboard.
Copy Photo Copy the photograph to the clipboard.
Copy Copy data from the current topic to the clipboard.
Hide Toolbar Hide the photograph toolbar.
Mute Toggle the video sound off and on.
Next Display the next topic (or photograph).
Off Turn the video off and return to the previous topic.
Play 
Fullscreen

Begin video playback (fullscreen) from the current position.

Play Sound Play an audio track related to the current photograph.
Play Begin video playback (in the video window) from the 

current position.
Previous Display the previous topic (or photograph).
Print Print the current topic (or photograph).
Return Display the topic which was visible before the show 

photographs mode was selected.
Rewind Rewind the video to the start position.
Show Toolbar Show the photograph toolbar.
Stop Stop video playback.
Volume Down Turn the volume down.
Volume Up Turn the volume up.



Copy Photo Command (Popup Menu)

This command copies the photograph to the clipboard.

Note:    Copying data to the clipboard replaces the previous contents of the clipboard.



Close Command (Popup Menu)

This command displays the topic related to the photograph.



Return Command (Popup Menu)

This command displays the topic visible before the show photographs mode was selected.



Play Sound Command (Popup Menu)

This command plays an audio track related to the photograph.



Copy Image Command (Popup Menu)

This command copies the embedded image to the clipboard.

Note:    Copying data to the clipboard replaces the previous contents of the clipboard.




